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Welcome to EPCwin 
Welcome to EPCwin – the professional embroidery digitizing software by ZSK. EPCwin 
transforms your creative ideas into precise stitch data that ZSK embroidery machines can 
bring to life on fabric. Whether you’re digitizing your first logo or crafting complex multi-
technique designs with sequins and special effects, EPCwin provides the tools you need. 

This guide is organized by experience level, so you can start wherever feels right for you: 

• Chapter 1 – Getting Started: Learn the interface, open your first design, and understand 
basic navigation. 

• Chapter 2 – Everyday Digitizing: Master the core stitch types, fill algorithms, and editing 
tools you’ll use daily. 

• Chapter 3 – Advanced Techniques: Explore specialty fills, sequin placement, auto-punch, 
and design programs. 

• Chapter 4 – Expert & Customization: Fine-tune parameters, use GiS vector workflows, 
and optimize production output. 

Every feature described in this guide is derived directly from the EPCwin source code. 
Where a feature’s exact behavior could not be fully determined from the code alone, it is 
marked as “to be confirmed.” 

Tip 

Colored boxes like this one appear throughout the guide. Green boxes contain practical 
tips, yellow boxes warn you about common mistakes, and blue boxes share useful 
background information. 

 

What Is EPCwin? 

EPCwin (Embroidery Pattern Creator for Windows) is a full-featured digitizing application. It 
lets you create embroidery patterns from scratch by placing individual stitches, defining 
outlines that the software fills automatically, importing vector graphics (DXF, SVG), 
converting TrueType fonts into stitches, and much more. The resulting stitch data can be 
exported to a wide range of machine formats for production on ZSK and other industrial 
embroidery machines. 
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Chapter 1 – Getting Started 
What you’ll learn in this chapter 

• How to navigate EPCwin’s main interface and workspace 

• How to open, create, and save embroidery designs 

• How to use the view controls (zoom, pan, rulers) 

• How to understand the stitch display and coordinate system 

• How to set up basic preferences and units 

 

1.1 The EPCwin Workspace 

When you launch EPCwin, you’ll see a workspace with several key areas: 

• Design Canvas: The large central area where your embroidery design is displayed. This is 
where you digitize, edit, and preview your stitch data. 

• Menu Bar: At the top – access to all file operations, editing tools, view settings, punch 
functions, design programs, and help. 

• Toolbars: Quick-access buttons for frequently used functions like punch mode, editing, 
and stitch display toggles. 

• Ruler: Horizontal and vertical rulers along the edges of the canvas. They show 
coordinates in your chosen unit (typically 1/10 mm). 

• Assistant Window: A context-sensitive panel that shows guidance, parameters, and 
status information depending on what you’re currently doing. 

• Status Bar: At the bottom – displays the current cursor position, stitch count, and active 
mode. 

Good to Know 

EPCwin uses 1/10 mm as its internal coordinate unit. All parameter values for stitch 
lengths, densities, and distances are expressed in 1/10 mm unless noted otherwise. For 
example, a stitch length value of 30 means 3.0 mm. 

 

  



EPCwin – User Guide 

ZSK Embroidery Machines | 9 

1.2 Opening and Saving Designs 

EPCwin supports a wide range of embroidery file formats for both import and export. The 
native format preserves all digitizing information including automation parameters, 
contours, and design blocks. 

Supported Machine Formats 

Format Description 

ZSK ZSK native stitch format 

ZSK TC ZSK Technical Collection format 

ZSK NC ZSK numerical control format 

ZSK ZEPL ZSK ZEPL format 

Tajima (DST) Industry-standard production format 

Barudan (FDR/FMC) Barudan machine formats 

Melco Melco machine format 

Fortron Fortron machine format 

SLC / SHC Schiffli formats 

LIF LIF exchange format 

Laesser Laesser machine format 

Hiraoka Hiraoka machine format 

Step-by-Step: Open a Design 

1. Go to File > Open or use the toolbar button. 

2. In the file dialog, select your embroidery file. EPCwin detects the format automatically. 

3. The design loads onto the canvas. You’ll see the stitch paths rendered in their assigned 
colors. 

4. Use the scroll wheel or View menu to zoom in and inspect details. 

Step-by-Step: Save / Export a Design 

1. Go to File > Save to store the design in EPCwin’s native format (preserving all digitizing 
data). 

2. Go to File > Export (or the machine output dialog) to write the stitch data in a machine-
specific format. 

3. Select the target machine stitch system (ZSK, Tajima, Barudan, Melco, etc.). 

4. Choose the output location – this can be a local folder, a network path, or a connected 
device. 
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Tip 

Always save your work in EPCwin’s native format before exporting to a machine format. 
Machine formats like DST or Tajima discard digitizing information (contours, parameters). If 
you only save in a machine format, you lose the ability to edit automation parameters later. 

1.3 View Controls 

EPCwin provides several tools for navigating your design: 

• Zoom: Scroll wheel to zoom in/out. Use View menu for preset zoom levels. 

• Pan: Click and drag in pan mode, or hold the middle mouse button to move around the 
canvas. 

• Rulers: The horizontal and vertical rulers update as you move, showing precise 
coordinates. 

• Fit to Window: Quickly zoom the entire design to fit your current window size. 

• Stitch View vs. Design View: Toggle between seeing the raw stitch paths and the design-
level view (contours, fill areas, automation objects). 

Watch Out 

Remember the difference between Stitch View and Design View. In Stitch View you see 
what the machine will actually sew. In Design View you see the high-level objects 
(contours, outlines) that generate those stitches. Editing works differently depending on 
which view is active. 

1.4 Understanding the Coordinate System 

EPCwin works in a Cartesian coordinate system with the origin (0,0) at the center of the 
embroidery frame. Positive X goes right, positive Y goes up. All values are in 1/10 mm: 

Value Real-World Equivalent 

10 1.0 mm 

100 10.0 mm (1 cm) 

1000 100.0 mm (10 cm) 

The machine frame defines the maximum stitchable area. EPCwin reads the frame 
definition from the pattern’s header data (MusterInfo) and displays it as a boundary on the 
canvas. 
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1.5 Basic Preferences 

Before you start digitizing, it’s worth reviewing a few settings: 

• Units: Confirm you’re working in your preferred measurement system. EPCwin internally 
uses 1/10 mm. 

• Color Palette: Set up your default needle color assignments so that the on-screen 
preview matches your intended thread colors. 

• Grid and Snap: Enable grid display and snap-to-grid if you need precise point placement. 

• Undo Levels: EPCwin supports multi-level undo. Make sure the undo depth is set to a 
comfortable number before starting a complex design. 

Before you move on – did you...? 

☐ Launch EPCwin and identify the canvas, menu bar, toolbars, ruler, and assistant window 

☐ Open a sample embroidery file and see it displayed on the canvas 

☐ Zoom in, zoom out, and pan around the design 

☐ Toggle between Stitch View and Design View 

☐ Save the file in EPCwin’s native format 

☐ Export the design to at least one machine format (e.g., ZSK or Tajima) 

☐ Check that your units and basic preferences are configured 
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Chapter 2 – Everyday Digitizing 
What you’ll learn in this chapter 

• How to use Punch Mode to place stitches and define contours 

• How to work with the core fill types: Comfort Fill, Flat Stitch, and Comfort Line 

• How to use Curved Fill for organic shapes 

• How to create text and monograms with TrueType fonts 

• How to edit stitches, select objects, and use the undo system 

• How to manage needle changes and special stitch functions 

• How to use the block system for organizing your design 

 

2.1 Punch Mode – The Heart of Digitizing 

Punch Mode is where you create embroidery data. In EPCwin, “punching” means placing 
reference points that define the shape of your design. The software then uses these 
reference points together with your chosen stitch program (fill type, stitch type) to 
generate the actual machine stitches. 

Punch Mode Workflows 

• Main Punching: Place contour points to define outlines. EPCwin generates stitches based 
on your active automation program. 

• Insert Mode: Add new points into an existing contour without re-digitizing the entire 
shape. 

• Reference Capture: Capture reference data from existing stitch patterns for re-
calculation. 

• Minus Operations: Remove or subtract points from existing contours. 

Step-by-Step: Digitize a Simple Shape 

1. Enter Punch Mode from the toolbar or menu (Punch > Start). 

2. Select your stitch program (e.g., Comfort Fill for a filled area, or Comfort Line for an 
outline). 

3. Click on the canvas to place reference points that define your shape’s outer contour. 

4. If the shape has inner holes, switch to the inner contour layer and place those points 
too. 

5. When your contour is complete, confirm the shape. EPCwin calculates and generates 
the stitches. 

6. Review the generated stitches in Stitch View. If the result isn’t right, adjust parameters 
and recalculate. 
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Tip 

Think of punching as drawing with constraints. You define the boundaries, and EPCwin’s 
algorithms fill in the stitches. The better your contour points, the better the stitch result. 
Place extra points in areas with tight curves. 

2.2 Comfort Fill – The Standard Area Fill 

Comfort Fill (ComfFill) is your go-to tool for filling areas with stitches. It’s versatile, well-
optimized, and suitable for most fill situations – from small lettering fills to large jacket-
back designs. 

Key Parameters 

Parameter Range & Meaning 

Density 1–100 (in 1/10 mm). Lower = denser fill. Typical production 
value: 4–6. 

Stitch Length (RSL) 2–127 (in 1/10 mm). The length of each running stitch 
within the fill. 

Running Distance 0–999 (in 1/10 mm). Distance for connecting runs between 
fill rows. 

Pull Compensation 0–999%. Widens the fill to compensate for fabric pull-in 
during stitching. 

Pull Limit 0–999 (in 1/10 mm). Maximum pull compensation distance. 

Swing 0–99 (in 1/10 mm). Adds a slight lateral offset for a softer 
fill appearance. 

Rhythm 0–10. Controls the stagger pattern. Includes Casual 
(random) and Macro modes. 

Macro Max 0–200. Maximum number of stencil elements when using 
Macro rhythm. 

Fill Application Types 

Comfort Fill supports several application modes: 

Mode Use Case 

Shadow Fill Standard area filling – your most common choice. 

Shadow Hatching Lighter fill with visible gaps – good for shading effects. 

Shadow Underlay A base layer stitched before the top fill for stability. 

Shadow Macro Fill using predefined stitch patterns (macros) instead of 
simple rows. 

Stitch Tuff Textured fill for raised, tufted effects. 
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Reversal Types 

When the fill reaches the edge of a contour and needs to reverse direction, you can 
choose how it turns: 

• Cross Connection: A straight stitch across the edge before reversing. Clean and efficient. 

• Hat Reversal: The needle rolls around the edge in a curve. Produces a softer, more 
rounded edge finish. 

Tip 

For most production work, start with a density of 4–5 and a stitch length of 40–50 (4–5 
mm). Adjust pull compensation based on your fabric: stretchy knits need 5–10%, stable 
wovens need 1–3%. 

Watch Out 

If your fill looks too thin at the edges, increase pull compensation. If the design puckers, 
reduce density or add proper underlay. Comfort Fill’s underlay mode can help stabilize the 
fabric before the top fill. 
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2.3 Flat Stitch (Satin/Column Stitch) 

The Flat Stitch (Plattstich) is the classic satin or column stitch used for narrow shapes like 
letter strokes, borders, and outlines. Each stitch spans the full width of the column, 
creating a smooth, shiny surface. 

Key Parameters 

Parameter Range & Meaning 

Density 1–999 (in 1/100 mm). Controls how closely packed the 
satin stitches are. 

Border Width 1–999 (in 1/10 mm). Width of the column. 

Pull Compensation -999 to 999%. Adjusts for fabric pull-in. Can be negative to 
pull inward. 

Pull Limit 0–999 (in 1/10 mm). Maximum pull correction. 

Density Ramps 0–10. Gradual density changes at corners for smoother 
transitions. 

Shortening Factor 0–150%. Reduces stitch length at tight curves to prevent 
bunching. 

Feed -20 to 20 (in 1/10 mm). Fine-tunes stitch placement for 
shortened stitches. 

Min Stitch Length 1–127 (in 1/10 mm). Prevents stitches from becoming too 
short. 

Fringe (Absolute) 0–99 (in 1/10 mm). Edge fringe effect. 

Fringe (Relative) 0–100%. Edge fringe as a percentage of column width. 

Corner Overstitch -999 to 999 (in 1/10 mm). Extra stitching at corner points. 

Corner Point Length 1–999 (in 1/10 mm). Length of corner compensation. 

Shift 0–127. Stagger pattern for the stitch start points. 

Swing 0–99 (in 1/10 mm). Lateral variation for natural look. 

Reversal Behavior 

Flat Stitch offers three reversal styles at column turns: 

• Cross (Quer): A sharp, clean turn – default for geometric shapes. 

• Hat (Hut): Rounded turn – better for organic curves. 

• Zigzag: A zigzag pattern at the turn – distributes thread more evenly. 
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Underlay Options 

EPCwin supports multiple underlay types for Flat Stitch, each adding stability beneath the 
satin surface: 

• Midline: A single line of stitches down the center of the column. 

• Parallel: Lines running parallel to the column edges. 

• Chain: A chain-like underlay pattern for extra stability on stretch fabrics. 

• Zigzag: A zigzag underlay that locks the fabric in both directions. 

Running Stitch Borders 

You can add running stitch borders alongside the satin column (0–2 running sides). These 
borders add definition and help lock down edges. Configure the running distance (0–999) 
and running stitch length (2–127) separately. 

Tip 

For lettering, use Flat Stitch with a column width of 15–25 (1.5–2.5 mm) and density of 35–
45. Add a midline underlay for crisp results. Increase the corner overstitch value for sharp 
letter corners like on “M” or “W”. 

2.4 Comfort Line – Running & Outline Stitches 

Comfort Line generates running stitches that follow a path. It’s used for outlines, detail 
lines, quilting paths, and any situation where you need a single line of stitches rather than 
a filled area. 

Key Parameters 

Parameter Range & Meaning 

Stitch Length 1–999 (in 1/10 mm). Length of each stitch along the path. 

Pull at Connection 0–999 (in 1/10 mm). Extra pull compensation at 
connection points. 

Shortening in Tight Curves 0–90%. Reduces stitch length in tight curves to maintain 
smooth lines. 

Number of Passes 1–5. How many times the line is stitched. Multiple passes 
create a bolder line. 

Pass Offset 1–3. Displacement between passes for a wider overall 
appearance. 

Swing 0–99 (in 1/10 mm). Side-to-side variation for a more 
natural line. 

Stitch Repetitions 1–99. Repeat individual stitches for extra coverage. 

Tip 

A 3-pass Comfort Line at stitch length 25–30 (2.5–3.0 mm) makes an excellent outline 
around filled areas. Add it after your fill to create a clean, professional border. 
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2.5 Curved Fill – For Organic Shapes 

Curved Fill (CurvFill) generates fill stitches that follow the natural curvature of your 
contour, rather than running in straight parallel rows. This produces a more natural look for 
organic shapes like leaves, petals, and flowing designs. 

Key Parameters 

Parameter Range & Meaning 

Stitch Length 1–127 (in 1/10 mm). Length of stitches within the curved 
rows. 

Pull Compensation 0–50 (in 1/10 mm). Edge compensation for fabric pull. 

Shortening 0–70%. Stitch shortening in tight curve areas. 

Number of Passes 1–3. Multiple passes for heavier coverage. 

Pass Offset 1–3. Displacement between repeated passes. 

Stitch Repetitions 1–9. Repeat each stitch. 

Swing 0–99 (in 1/10 mm). Lateral variation. 

Reversal Types 

Curved Fill provides four different reversal styles: 

• Cross Connection: Straight crossover at contour edges. 

• Hat Reversal: Smooth, rounded turn at edges. 

• Round Reversal: Circular turning motion – ideal for very organic shapes. 

• Corner Reversal: Sharp angled turn – good for shapes with defined corners. 

Good to Know 

Curved Fill uses three application modes: Curved Fill Stitching (for production), Curved Fill 
Drawing (for preview), and Simple Curved Drawing (for quick visualization). 
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2.6 TrueType Text & Monograms 

EPCwin can convert any installed TrueType or OpenType system font into embroidery 
stitches. This means you can use fonts like Arial, Times New Roman, or any decorative font 
to create text-based embroidery. 

Font Workflow 

1. Open the TrueType / Monogram function from the menu. 

2. Select your desired font from the Font Chooser, which shows all system-installed fonts. 

3. Type your text or monogram characters. 

4. Set the character height and spacing parameters. 

5. EPCwin converts the font outlines into embroidery contours and generates stitches 
using your chosen fill program. 

Monogram Features 

The Monogram module provides additional capabilities beyond simple text: 

• Character-level spacing control (left and right spacing per character). 

• Precise extent tracking: top, bottom, left, right bounds for each character. 

• Size properties: width, height, center point, and baseline for accurate placement. 

• Block directory system supporting up to 256 characters per block directory, with up to 
300 directories. 

• Password protection for monogram block libraries. 

• Design Monogram mode for creating monograms within design programs. 

Tip 

When converting TrueType fonts, thin strokes may produce very narrow satin columns. 
Check the minimum stitch width and consider using a slightly bolder font weight for small 
text sizes. 
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2.7 Stitch Editing 

Once stitches are generated, EPCwin provides a full-featured editor for refining the result. 
The editor operates in several modes: 

Mode Purpose 

Normal Editor General stitch-level editing: move, delete, insert stitches. 

Global Edit Apply changes across the entire design (e.g., scale, rotate, 
mirror). 

Insert Mode Add new stitches into an existing stitch sequence. 

Selection Editing Work only with currently selected stitches. 

Verify Mode Check stitch data for errors, validate stitch functions. 

Design Edit Edit at the design/automation level rather than individual 
stitches. 

Marker Mode Place and manage reference markers in the stitch 
sequence. 

Selection Tools 

EPCwin offers multiple ways to select stitches for editing: single stitch selection, range 
selection (from stitch A to stitch B), area selection (rubber-band rectangle), and object-
level selection in Design View. 
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2.8 Special Stitch Functions 

Beyond basic stitches, EPCwin supports a comprehensive set of special functions that 
control machine behavior during embroidery: 

Function What It Does 

Needle Change Switches to a different needle/thread color. 

Trim (Thread Cut) Cuts the thread between sections to avoid long jump 
stitches. 

Stop Pauses the machine – useful for operator interventions. 

Jump to Start Moves the frame back to the start position. 

Pattern End Marks the end of the embroidery data. 

Drill Activates the boring/drill function for eyelet holes. 

Sequin Right/Left Places a sequin from the right or left dispenser. 

Bead Device Right/Left Activates the bead placement device. 

Cord Activates cord/cording attachment. 

Loop Creates a loop stitch (chenille-style). 

Application Triggers an application (appliqué) function. 

Marker Places a reference marker in the stitch data. 

Sequence 1/2/3 Activates auxiliary sequence functions. 

Stitch length filters and angle filters can also be set as special functions, controlling the 
maximum stitch length (filter values from 1–3 levels) and minimum angle for stitch 
placement. 

Good to Know 

Special stitch functions are inserted into the stitch data at specific points. They tell the 
machine to perform an action at that exact moment in the embroidery sequence. The 
order matters – a needle change before a fill section means the fill stitches will use the 
new color. 

2.9 Working with Blocks 

Blocks are EPCwin’s organizational units. You can group stitches, contours, or design 
objects into blocks and then move, copy, delete, or transform them as a unit. This is 
essential for managing complex multi-element designs. 

• Create a block by selecting a range of stitches or objects and grouping them. 

• Move blocks by entering offset values or dragging. 

• Copy blocks to duplicate design elements quickly. 

• Use the Block dialog for precise block management operations. 

• Blocks can be saved and loaded from block directory files for reuse across designs. 
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2.10 Undo / Redo 

EPCwin provides a multi-level undo system. Every editing action is recorded, and you can 
step backward through your edit history to restore previous states. This works for stitch 
edits, contour modifications, block operations, and parameter changes. 

Watch Out 

Undo history is cleared when you close the design file. Save frequently to create your own 
recovery points. 

Before you move on – did you...? 

☐ Enter Punch Mode and digitize a simple closed shape 

☐ Generate a Comfort Fill and experiment with density and stitch length 

☐ Create a Flat Stitch (satin) column for a narrow shape like a letter stroke 

☐ Draw an outline using Comfort Line with multiple passes 

☐ Try Curved Fill on an organic, non-rectangular shape 

☐ Convert a TrueType font to embroidery stitches 

☐ Edit individual stitches in the stitch editor 

☐ Insert a needle change and a trim function into a stitch sequence 

☐ Create and move a block of stitches 

☐ Use Undo to reverse at least one editing action 
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Chapter 3 – Advanced Techniques 
What you’ll learn in this chapter 

• How to use Cross Stitch and Cross Boll effects 

• How to work with Sequin (Paillette) line and area placement 

• How to digitize bore effects (eyelets, drill holes, cut holes) 

• How to use specialty fills: GiS Fill, Comfort Fill Plus, Comfort Fill Block 

• How to import vector graphics (DXF, SVG) and use Auto-Punch 

• How to use design programs (Honeycomb, Maze, Brick, Grid, Spiral fills) 

• How to chain and arrange pattern elements 

• How to use contour operations (parallels, spirals, Hilbert curves) 

 

3.1 Cross Stitch 

The Cross Stitch module generates traditional cross-stitch patterns. It supports 11 
different stitch types and produces the characteristic X-shaped stitches used in counted 
cross-stitch embroidery. 

Key Parameters 

Parameter Range & Meaning 

Type 1–11. Selects the cross stitch pattern variation. 

Size 1–30. Size of each cross in the grid. 

Count 1–100. Number of crosses per row or column. 

Stitch Length 0–127 (in 1/10 mm). Individual stitch length within each 
cross. 

Pull Compensation 0–9. Adjusts for fabric pull-in. 

Cross stitches can start from any of the four corners (lower-left, upper-left, upper-right, 
lower-right) and can be stitched in either cross or zigzag mode. 
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3.2 Cross Boll 

Cross Boll (Kreuzbollen) creates decorative raised-stitch elements, often used for textured 
fills, bobbin work, or heavy embroidery effects. 

Key Parameters 

Parameter Range & Meaning 

Radius 0.1–1000. Size of each boll element. 

Circumference Passes 1–99. Number of stitch passes around each element. 

Width Change 0–100%. Progressive width variation across the element. 

Density Change 1–99. Gradual density variation. 

Zigzag Distance 3–999. Spacing of the zigzag structure. 

Pull Compensation -999 to 999%. Fabric compensation. 

Pull Limit 0–999 (in 1/10 mm). Maximum pull correction. 

Max Stitch Length 0–999 (in 1/10 mm). Caps individual stitch length. 

Shift Types 

• No Shift: Bolls are placed in a regular grid. 

• Edge Transition: Bolls shift smoothly at contour edges for a natural boundary. 

• Tangential Transition: Bolls follow the contour tangent for flowing placement. 

3.3 Sequin / Paillette Placement 

EPCwin provides dedicated tools for digitizing sequin (Paillette) embroidery, both along 
lines and within filled areas. Sequin embroidery is widely used in fashion, costume design, 
and decorative textiles. 

Sequin Shapes 

Shape Description 

Circle Standard round sequin – the most common type. 

Rectangle Square or rectangular sequin. 

Diamond Rotated square (rhombus) shape. 

Flower 1 / Flower 2 Decorative flower-shaped sequins. 

Free Form Custom sequin shape defined by the user. 
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Stitch Art for Sequins 

EPCwin supports multiple securing stitch patterns for holding sequins in place: 

Stitch Art Description 

2-Point Row Two stitches per sequin, placed in rows. 

3-Point Row Three stitches per sequin for extra security. 

Y-Stitch Y-shaped securing pattern. 

I-Stitch Single straight stitch through the center. 

E-Stitch / V-Stitch E- or V-shaped patterns for decorative securing. 

IV / EV Stitch Combined stitch patterns. 

Bead Type 1/2/3 Securing patterns specifically for bead/pearl placement. 

Key Parameters 

Parameter Range & Meaning 

Overstitch 0–999 (in 1/10 mm). How far the securing stitch extends 
beyond the sequin edge. 

Intermediate Stitch Length 1–999 (in 1/10 mm). Stitch length between sequins. 

Overlap -120 to 999. How much adjacent sequins overlap each 
other. 

Stitch Angle 0–180°. Orientation of the securing stitches. 

Repetition 0–99. Number of securing stitch repetitions per sequin. 

Bean Stitch Width 0–99. Width when using bean stitch mode. 

Bean Stitch Layers 3–9. Number of layers for bean stitch. 

Row Spacing 0–80% (relative) or 10–3250 (absolute). Spacing between 
rows of sequins. 

Row Offset 0–8. Staggering between sequin rows for a more natural 
pattern. 

Sequin Area Fill 

The Paillette Area (PailletteFlaeche) function fills an enclosed contour with sequins, using 
the same shape and stitch art options as line placement but arranged in a grid pattern 
across the entire area. 

Tip 

When placing sequins, always stitch a test sample first. The overlap parameter is critical – 
too little overlap and you’ll see fabric between sequins; too much and they’ll bunch up. 
Start with an overlap of 10–20% of the sequin diameter. 
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3.4 Bore Effects (Eyelets & Cut Holes) 

Bore effects create openings in the fabric, reinforced with stitching around the edge. 
They’re used for eyelet holes in garments, decorative perforations, and functional 
openings. 

Effect Description 

Drill Hole (Bohrloch) A round eyelet reinforced with satin stitches around the 
rim. 

Pear Hole (Birnenloch) A teardrop/pear-shaped opening. 

Cut Hole (Schneidloch) A slit-style opening reinforced with stitching. 

Cut Hole 2 A variant cut hole with different stitching geometry. 

Drill Rectangle A rectangular opening with satin-stitched edges. 

Drill Semicircle A semicircular opening. 

Each bore effect has two variants: a production version (for actual stitching) and a preview 
version (for on-screen visualization). The machine’s drill mechanism activates during 
production to cut the fabric. 

Watch Out 

Bore effects require a machine equipped with a boring/drill attachment. Verify that your 
target machine supports the drill function before digitizing eyelets into production designs. 
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3.5 Specialty Fill Types 

GiS Fill 

GiS Fill is an advanced fill algorithm developed by GiS (the software engine underlying 
EPCwin). It provides finer control over fill behavior for complex shapes. 

Parameter Range & Meaning 

Ramp 0–10. Gradual density change at contour edges. 

Shortening 0–200%. Stitch shortening factor in curves. 

Overlap 0–999. Stitch overlap at fill boundaries. 

Cover Stitch Swing 0–999. Top stitch variation. 

Contour Underlay Count 1–3. Number of contour-following underlay passes. 

Contour Underlay Distance 0–999. Offset from contour edge. 

Area Underlay Count 0–2. Number of area underlay passes. 

Area Underlay Density 0–999. Density of area underlay. 

Area Underlay Angle 0–999. Angle of area underlay stitches. 

Pull Compensation 0–100%. Fabric pull correction. 

Fringe 0–999 (absolute) / 0–100% (relative). 

Division 0–100%. Row division factor. 

Rhythm 1–8. Stagger pattern for the fill rows. 

Rhythm Angle 0–90°. Angle-based rhythm variation. 

Comfort Fill Plus 

Comfort Fill Plus (CFP) extends the standard Comfort Fill with support for raster-line 
generation, area division, and multi-layer complex fills. It’s designed for shapes that are 
too complex for standard Comfort Fill – for example, areas with multiple holes, narrow 
bottlenecks, or irregular boundaries. 

Good to Know 

If Comfort Fill gives you error messages about contour complexity, try Comfort Fill Plus. It 
handles more challenging geometries with its raster-line and area-division algorithms. 
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Comfort Fill Block 

Comfort Fill Block divides a fill area into rectangular blocks and fills each one separately. 
This creates a structured, segmented appearance. 

Parameter Range & Meaning 

Block Size 2–127 (in 1/10 mm). Width of each fill block. 

Offset -127 to 127 (in 1/10 mm). Shift each block row. 

Factor -99 to 200%. Size scaling factor. 

Minimum 1–127 (in 1/10 mm). Minimum block size. 

Shift (Versatz) 0–99%. Offset percentage between rows. 

Direction 0–1. Fill direction toggle. 

Mirror 0–1. Mirror the block pattern. 

3.6 Design Programs 

Design Programs are pre-configured stitch patterns for specific decorative and structural 
effects. EPCwin includes a rich library: 

Column & Border Effects 

Program Description 

Drill Screw (Bohrstaeffel) A drill-like screw column with layered satin stitching. 

Pull Screw (Zugstaeffel) Screw column that creates a pulled-thread effect. 

Double Pull Screw Two parallel pull-screw columns. 

Border (Rand) A single decorative border line. 

Double Border Two parallel border lines. 

Winding Line (Wickellinie) A spiraling wrap-around line stitch. 
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Area Fill Effects 

Program Description 

Pull Hollow (Zughoehl) Open-work fill with a pulled-thread look. 

Fabric Hollow (Stoffhoehl) A fill that mimics woven fabric texture. 

Honeycomb Hollow 
(Wabenhoehl) 

Hexagonal honeycomb pattern fill. 

Drill Hollow (Bohrhoehl) Open-work fill with drilled holes. 

Brick Fill (Ziegelhoehl) A brick-wall pattern fill. Also available in curved variant. 

Grid Hollow (Gitterhoehl) Grid/lattice pattern fill. 

Maze (Irrgarten) Maze-like decorative fill pattern. 

Parallel Fill Simple parallel-line fill. 

Spiral Fill Spiral pattern radiating from center. 

Design Program Parameters 

All design programs share a common parameter set: 

Parameter Range & Meaning 

Size X / Y 0.1–1000. Dimensions of the repeating element. 

Cross Distance X / Y 0.1–50. Spacing between elements. 

Border Width 0.1–1000. Width of border/outline. 

Underlay Count 0–10. Number of underlay passes. 

Underlay Stitch Length 1–999. Stitch length for underlay. 

Border Distance 1–999. Offset of border from fill edge. 

Stitch Count 0–10. Stitches per element. 

Tip 

Design programs are powerful for decorative and specialty embroidery. Start with the 
default parameters, then tweak the element size and cross distance to achieve the look 
you want. Always test on a sample swatch before production. 
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3.7 Vector Import (DXF & SVG) 

EPCwin can import vector graphics as a starting point for digitizing: 

DXF Import 

DXF (Drawing Exchange Format) files from CAD applications can be imported and 
converted into embroidery contours. Supported DXF elements include lines, arcs, circles, 
and polylines. The import process handles scaling and rotation to fit your design area. 

SVG Import 

SVG (Scalable Vector Graphics) files are imported with support for paths (including Bezier 
curves), basic shapes (circles, rectangles, polygons), and group/layer structures. SVG 
paths are converted into spline contours that EPCwin’s automation programs can then fill 
with stitches. 

Good to Know 

Vector import gives you clean outlines to work with, but you still need to assign stitch 
programs and parameters to each contour. Think of imported vectors as the skeleton – 
you add the embroidery intelligence on top. 

3.8 Auto-Punch (Automatic Digitizing) 

The GiS Auto-Punch module provides automatic digitizing from vector input. It analyzes 
the geometry of your contours and attempts to generate stitch data automatically. 

How Auto-Punch Works 

1. Import or create your vector design (contours, outlines, filled areas). 

2. Launch Auto-Punch from the GiS menu. 

3. The algorithm decomposes complex figures into simpler components. 

4. It detects branches, endpoints, and layer relationships in the vector data. 

5. Stitch paths are generated automatically, optimizing for minimal jump stitches and 
clean connections. 

6. Review the result and manually refine any areas where the automatic algorithm didn’t 
produce ideal output. 

Watch Out 

Auto-Punch works best with clean, well-structured vector artwork. Overlapping shapes, 
very thin elements, or highly complex contours may require manual cleanup before or 
after auto-punching. 
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3.9 Chaining & Arranging 

Chaining (Verketten) 

The Chaining function connects multiple pattern blocks into a sequence. This is useful for 
repeating elements along a path. 

Parameter Range & Meaning 

Reduction 0–70%. Progressive size reduction along the chain. 

Line Offset -999 to 999 (in 1/10 mm). Vertical offset of each block. 

Placement Angle -90 to 90°. Tilt of each element in the chain. 

Block Distance -999 to 999 (in 1/10 mm). Spacing between blocks. 

Block Count 2–999. Number of blocks in the chain. 

Min Stitch Length 1–127 (in 1/10 mm). Minimum stitch length within chained 
elements. 

Arranging (Anordnen) 

The Arrange function distributes blocks in a circular or angular pattern around a center 
point. This is perfect for creating radial designs like clock faces, flower patterns, or star 
shapes. 

Parameter Range & Meaning 

Division Angle 1–360°. Angular spacing between arranged copies. 

Division Count 1–360. Number of copies to arrange. 

Stitch Length Between 1–127 (in 1/10 mm). Connecting stitches between arranged 
elements. 

3.10 Contour Operations 

EPCwin provides advanced contour manipulation tools: 

• Parallel Contours: Generate parallel copies of a contour at a specified offset. Includes 
Voronoi-based parallel generation for complex shapes. 

• Form Spiral: Transform a contour into a spiraling path – creates spiral fill patterns and 
decorative effects. 

• Hilbert Curve: Generate Hilbert curve patterns within a contour – a mathematical space-
filling curve that creates unique, dense fill patterns. 

Good to Know 

Hilbert curves are a space-filling fractal that visits every point in an area. In embroidery, 
this creates an unusual, maze-like fill with no visible row pattern – a striking effect for 
modern, geometric designs. 
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3.11 Repeat / Rapport 

The Rapport (repeat) function duplicates a design element in a regular grid pattern. 
Configure the X and Y offset (-9999 to 9999) and count (0–999) to create allover patterns 
for fabric embroidery, quilting, or continuous border designs. 

Before you move on – did you...? 

☐ Generate a Cross Stitch pattern with at least one type variation 

☐ Place sequins along a line using Paillette Line, choosing a securing stitch art 

☐ Create at least one bore effect (e.g., a drill hole eyelet) 

☐ Try GiS Fill with contour underlay on a complex shape 

☐ Import a DXF or SVG vector file and assign stitch programs to the contours 

☐ Use Auto-Punch on a simple vector design and review the result 

☐ Chain multiple blocks into a repeating sequence 

☐ Arrange elements in a circular pattern using the Arrange function 

☐ Experiment with one Design Program (e.g., Honeycomb or Maze fill) 

☐ Generate a parallel contour or a Hilbert curve fill 
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Chapter 4 – Expert & Customization 
What you’ll learn in this chapter 

• How to fine-tune stitch generation with advanced parameters 

• How to work with the GiS vector engine and color gradients 

• How to configure machine-specific head parameters 

• How to use Thread Matching (Garnmatching) for color management 

• How to use design protection (ProProtect) 

• How to work with the pattern management system and network features 

• How to understand error codes and resolve calculation failures 

• How the spline and decomposition engines work internally 

 

4.1 Deep Parameter Control 

Every stitch program in EPCwin has a comprehensive parameter set. Parameters can be 
managed through the Parameter dialogs (Dialog/DialogParameter), which provide 
categorized access to all settings. EPCwin stores parameter sets that you can save, load, 
and share between designs. 

Parameter Workflow 

1. Open the Parameter dialog for your active stitch program. 

2. Adjust values using the input fields. Each field shows the valid range. 

3. Preview the effect of your changes (some programs support live preview). 

4. Save the parameter set if you want to reuse it. 

5. Apply the parameters to generate or re-generate stitches. 

Stitch Sequence Control 

The Stitch Sequence (Stichfolge) function controls the order in which stitch elements are 
executed, with up to 200 sequence positions. This determines the stitching path through 
your design and directly affects production efficiency and thread usage. 

Tip 

Save parameter sets for your most common fabric/thread combinations. You might have a 
“Polo Cotton” set (higher pull comp, medium density), a “Nylon Jacket” set (lower density, 
more underlay), and a “Cap Front” set (dense fill, heavy underlay). This speeds up repeat 
work enormously. 

 

  



EPCwin – User Guide 

ZSK Embroidery Machines | 33 

4.2 The GiS Vector Engine 

EPCwin’s advanced features are powered by the GiS (Graphische Informationssysteme) 
engine, which handles vector-based design operations. 

GiS Components 

• GisDocument: The central document management class that holds the entire design in 
vector form. 

• GisOutlineObject: Individual vector shapes within the design. 

• Stitch Type Picker: Interactive tool for selecting which stitch program to assign to each 
vector object. 

• Color Gradient (Farbverlauf): Apply color gradient effects across fill areas – the needle 
color transitions gradually across the design. 

• Layer Alphabet: A naming/ordering system for vector layers within a GiS design. 

• GiS to EPC Conversion: Converts GiS vector data into EPCwin’s native stitch format. 

Vector-to-Stitch Workflow 

1. Create or import your vector design in GiS mode. 

2. Assign stitch programs to each vector object using the Stitch Type Picker. 

3. Configure parameters per object (fill type, density, underlay, etc.). 

4. Run the GiS-to-EPC conversion to generate stitch data. 

5. Review and refine the stitch output in the normal EPCwin editor. 

Good to Know 

The GiS engine supports advanced grouping (GisBs_grupp) and base data management 
(GisBs_daten), allowing you to organize complex vector designs into manageable 
hierarchies before converting to stitches. 

4.3 Machine Head Configuration 

EPCwin supports multi-function machine heads, each with its own timing and parameter 
settings. This is relevant for machines equipped with special attachments. 

Winding Head (W-Kopf) 

Function Parameters 

Ribbon (Bändchen) Fabric presser height setting. 

Winding (Wickeln) Fabric presser height, offset angle (0–359°), winding ratio 
stitches (1–9), winding ratio winding (1–3). 

Zigzag Fabric presser height. 

Stitching (Sticken) Fabric presser height. 
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Kettle Head (K-Kopf) 

The Kettle Head has detailed timing parameters for its mechanized operations: 

• Leger start position (0–31) 

• Fabric presser down/up timing (0–31) 

• Needle up position (23–54) 

• Pantograph start (0–31) 

• Stitch mode (0–255) 

• Moss mode with similar parameters 

Frill Head (F-Kopf) 

Support for decorative gathering/frill attachments. 

Watch Out 

Machine head parameters directly control physical machine timing. Incorrect values can 
cause mechanical problems. Only adjust these settings if you have detailed knowledge of 
your machine’s head configuration or are following instructions from ZSK service 
documentation. 

4.4 Thread Matching (Garnmatching) 

The Thread Matching module (IOData/Garnmatching) manages the mapping between 
design needle numbers and physical thread colors. It works with color tables (Farbtabellen) 
that define available thread palettes. 

• Color tables store RGB values for thread visualization on screen. 

• Needle-to-color assignments are stored in the pattern header (MusterInfo). 

• The matching dialog lets you visually assign colors to each needle position. 

• Color tables can be imported, exported, and customized for your thread inventory. 

4.5 Design Protection (ProProtect) 

EPCwin includes a design protection system to safeguard your digitizing work. ProProtect 
allows you to password-protect embroidery files, preventing unauthorized modification or 
copying of your stitch data. This is especially important for commercial digitizers who sell 
or license their designs. 

Good to Know 

To be confirmed: the exact protection mechanisms and encryption level of ProProtect may 
vary by EPCwin version and license level. 
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4.6 Pattern Management & Network 

EPCwin provides a structured file management system: 

Pattern Info (MusterInfo) 

Every design carries a rich header (MusterInfo) containing: 

• Design metadata (name, author, date, version). 

• Machine frame definition – the maximum stitchable area. 

• Design parameters – automation settings used during digitizing. 

• Stitch sequence information for ordered execution. 

• Paillette/sequin definitions. 

• Special function macros (SfMakros). 

• Needle mapping for multi-head machines. 

• ZEPL settings for ZSK ZEPL machines. 

Directory Structure 

The pattern management system (MusterVerwaltung) organizes files into a configurable 
directory structure (Ablagestruktur) with tools for file operations, search, and batch 
management. 

Network Features 

EPCwin supports network operations (IOData/Netzwerk) for sharing designs across a local 
network, sending stitch data directly to networked machines, and collaborative workflows. 

4.7 Understanding Error Codes 

When stitch generation fails, EPCwin provides specific error codes to help you diagnose 
the problem: 

General Errors 

Code Meaning 

0 (No Error) Calculation completed successfully. 

1 (User Abort) You cancelled the operation. 

2 (Program Error) Internal software error – contact support with details. 

3 (Unknown Error) An unclassified error occurred. 

4 (No Stitches) The calculation produced zero stitches – check your 
contour and parameters. 

5 (Underlay Error) The underlay program failed – check underlay parameters. 
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Contour & Geometry Errors 

Code Meaning 

10 (Outer Contour Error) The outer contour is missing or invalid. Ensure your shape 
is closed. 

11 (Boundary Layer Error) Boundary layers are missing. Check that you defined the 
required guide lines. 

12 (Parameter Set Error) Required parameter set is missing. Open the parameter 
dialog and verify. 

13 (Parameter Content Error) Parameter values are out of range. Check all values 
against the valid ranges. 

14 (Stitch Layer Error) The stitch layer definition is incorrect. 

15 (Center Error) Missing or invalid center point. 

16 (Start Point Error) Start point is not defined or is outside the contour. 

17 (End Point Error) End point is not defined or is outside the contour. 

GiS Fill Specific Errors 

Code Meaning 

21 (Odd Intersection Count) The fill algorithm found an odd number of intersections 
with the contour – this usually means the contour self-
intersects. 

22 (No Partial Areas) The area could not be divided into fillable sub-areas. 

23 (No Fill Direction) No fill direction could be determined – define a guide line. 

25 (Curve List Error) Internal error in the curve data structure. 

26 (Contour/Hole Overlap) An inner hole overlaps the outer contour. 

30 (Contour/Hole Loop) A loop was detected between contour and hole 
boundaries. 

33 (Layer Too Short) A fill layer is too short to generate stitches. 

Tip 

Most errors come down to contour quality. If you get repeated errors, zoom in and inspect 
your contours for self-intersections, duplicate points, or gaps. The “Verify” mode in the 
editor can help identify problem areas. 
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4.8 The Spline Engine 

EPCwin uses Bezier splines internally for smooth contour representation. The spline 
engine provides: 

• Graph-to-Spline Conversion: Converts point-based contours into smooth spline curves. 

• Spline-to-Graph Conversion: Converts smooth splines back to discrete points for stitch 
generation. 

• Parallel Splines: Generates parallel offset curves for underlay paths and column edges. 

• Midline Calculation: Computes the midline between two contour edges – used for satin 
column center lines. 

• Intersection Detection: Identifies where splines cross – essential for fill boundary 
computation. 

4.9 Decomposition Algorithms 

When generating fill stitches, EPCwin’s internal algorithms decompose areas into fillable 
segments: 

• Normal Decomposition: Standard row-by-row decomposition for regular fills. 

• Casual Decomposition: Randomized decomposition for a less regular, more natural 
appearance. 

• Division Spline Decomposition: Uses spline-defined division lines for complex area 
segmentation. 

• Inner Point Calculation: Determines optimal start/end points within fill areas. 

4.10 Statistics & Reporting 

The Statistics module (Statistik) provides detailed analysis of your embroidery data: stitch 
counts, color distribution, thread consumption estimates, design dimensions, and 
estimated execution time. Use these reports for production planning and customer 
quoting. 
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4.11 Printing 

EPCwin can print design worksheets showing the stitch preview, color chart, needle 
assignments, dimensions, and stitch counts. The Print module supports standard Windows 
printers and generates professional output suitable for production floor documentation. 

Before you move on – did you...? 

☐ Save and load a custom parameter set for your preferred fabric type 

☐ Understand the Stitch Sequence (Stichfolge) and its impact on production order 

☐ Use the GiS Stitch Type Picker to assign programs to vector objects 

☐ Review the machine head parameters relevant to your equipment 

☐ Set up thread matching using your thread manufacturer’s color table 

☐ Know how to interpret the most common error codes (10, 11, 12, 21) 

☐ Generate a design statistics report 

☐ Print a design worksheet for production reference 
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Chapter 5 – Troubleshooting & FAQ 
What you’ll learn in this chapter 

• Solutions to the most common digitizing problems 

• Answers to frequently asked questions 

• Where to get additional help 

 

5.1 Troubleshooting Guide 

Stitch Generation Failures 

Problem Solution 

"Outer Contour Error" (Code 10) Your shape’s outer contour is not closed or is invalid. Zoom 
in and verify that the first and last points of the contour 
meet. Look for self-intersecting segments. 

"No Stitches Generated" (Code 
4) 

The calculation produced no output. Possible causes: the 
area is too small for the current density setting, or the 
contour is degenerate (zero area). Try increasing the area 
or reducing density. 

"Boundary Layer Error" (Code 
11) 

The stitch program requires guide lines (boundary layers) 
that you haven’t defined. For Flat Stitch, add left and right 
boundary lines. For fills, add a direction line. 

"Parameter Set Error" (Code 12) Open the parameter dialog and confirm all values are 
within the valid ranges shown in this guide. A missing or 
corrupted parameter file can also cause this. 

Fill looks uneven or patchy Check for contour self-intersections (Code 21: odd 
intersection count). Also verify that inner holes don’t 
overlap the outer contour (Code 26). 

Calculation takes very long The shape may be too complex for the selected program. 
Try simplifying the contour, reducing the number of inner 
holes, or switching to Comfort Fill Plus for complex 
geometries. 

Display & Navigation Issues 

Problem Solution 

Design appears blank after 
opening 

The design may be located far from the origin. Use View > 
Fit to Window to zoom to the design extents. 

Stitches visible but contours 
are not 

You’re in Stitch View. Switch to Design View to see the 
underlying contours and automation objects. 

Colors look wrong on screen The needle-to-color mapping may not match your 
intended thread palette. Open Thread Matching to 
reassign colors. 
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File & Export Issues 

Problem Solution 

Exported file won’t load on the 
machine 

Verify you selected the correct stitch system for your 
machine (ZSK, Tajima, Barudan, etc.). Some machines 
have specific file format requirements. 

Design data lost after export 
and re-import 

Machine formats (DST, etc.) discard digitizing data. Always 
keep a copy in EPCwin’s native format alongside the 
machine export. 

Network send fails Check network connectivity. Verify the target path is 
accessible and writable. Ensure no other process has the 
target file locked. 

Sequin & Special Function Issues 

Problem Solution 

Sequins not placed at correct 
positions 

Check the overlap and stitch angle parameters. Verify the 
sequin shape matches your physical sequins. Stitch a test 
sample. 

Drill function not activating on 
machine 

Confirm the machine has a drill attachment and it’s 
enabled. Check that the drill special function is correctly 
placed in the stitch sequence. 

Thread breaks during 
production 

Review the stitch sequence for excessively long stitches. 
Check stitch length filters. Ensure pull compensation is not 
overcompensating. 
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5.2 Frequently Asked Questions 

General 

Q: What embroidery file formats can EPCwin read and write? 

A: EPCwin supports ZSK (native, TC, NC, ZEPL), Tajima, Barudan (FDR/FMC), Melco, 
Fortron, SLC, SHC, LIF, Laesser, and Hiraoka formats. The native ZSK format preserves all 
digitizing information; machine formats typically contain only stitch data. 

 

Q: Can I import vector graphics into EPCwin? 

A: Yes. EPCwin supports DXF and SVG import. DXF files from CAD software and SVG files 
from design tools like Adobe Illustrator or Inkscape can be imported and converted into 
embroidery contours. You then assign stitch programs to the imported shapes. 

 

Q: What is the difference between Stitch View and Design View? 

A: Stitch View shows the actual machine stitches – what the machine will sew. Design 
View shows the high-level digitizing objects: contours, fill boundaries, and automation 
parameters. Editing works differently in each view. Use Design View for contour editing 
and Stitch View for stitch-level adjustments. 

 

Q: How do I use TrueType fonts for embroidery? 

A: EPCwin converts any installed system font into embroidery data. Select the 
Monogram/TrueType function, choose a font, type your text, and EPCwin generates 
contours and stitches automatically. You can then edit the result like any other embroidery 
object. 

Digitizing Technique 

Q: Which fill type should I use for a large area? 

A: For most large areas, Comfort Fill with a density of 4–6 is the best starting point. For 
areas with complex shapes or many holes, try Comfort Fill Plus. For a more organic look on 
curved shapes, use Curved Fill. For decorative patterns, explore the Design Programs 
(Honeycomb, Maze, Brick, etc.). 

 

Q: How do I prevent puckering (fabric pulling)? 

A: Puckering is caused by too many stitches pulling the fabric. Solutions include reducing 
fill density, adding proper underlay (stabilizes the fabric before the top fill), increasing pull 
compensation, and ensuring the correct stabilizer/backing is used for the fabric type. GiS 
Fill’s contour underlay options are particularly effective. 
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Q: What is pull compensation and how much should I use? 

A: Pull compensation widens the fill slightly to counteract the fabric pulling inward during 
stitching. The right amount depends on your fabric: 1–3% for stable wovens, 5–10% for 
knits, and up to 15% for very stretchy materials. Always test on a sample first. 

 

Q: How do I create a smooth satin column for lettering? 

A: Use Flat Stitch (Plattstich) with a column width matching your desired letter stroke 
width. Set density to 35–45, add a midline underlay, and use density ramps of 2–4 for 
smooth corners. The corner overstitch parameter is key for sharp letter corners. 

Advanced Features 

Q: What is Auto-Punch and when should I use it? 

A: Auto-Punch automatically converts vector outlines into stitch data. Use it for simple 
logos and shapes where manual digitizing would be tedious. For complex or high-quality 
designs, manual digitizing with EPCwin’s tools typically produces better results. 

 

Q: Can I protect my embroidery designs from unauthorized use? 

A: Yes. EPCwin’s ProProtect feature allows you to password-protect your stitch files. 
Protected files can be sent to machines for stitching but cannot be modified without the 
password. 

 

Q: What are Design Programs? 

A: Design Programs are pre-configured stitch patterns for specific effects: Honeycomb, 
Maze, Brick, Grid, Spiral, various Hollow patterns, Screw columns, and Borders. They 
produce complex decorative results from simple contour input. 
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5.3 Getting Support 

If this guide doesn’t answer your question: 

• ZSK Dealer: Your primary contact for software support, training, licensing, and upgrades. 

• ZSK Stickmaschinen: Visit zsk.de for product information, documentation, and contact 
details. 

• In-Application Help: EPCwin includes context-sensitive help through the Assistant 
Window. It provides guidance relevant to your current activity. 

• Version Information: Check your EPCwin version via the Help menu. Always include this 
when reporting issues. 

Tip 

When reporting a problem to support, include: your EPCwin version, the exact error code or 
message, the file you were working with (if possible), and the steps to reproduce the issue. 
Screenshots of the error state are extremely helpful. 
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Appendix 

A. Supported Machine Stitch Systems 

System Format Code 

ZSK 1 

Tajima 2 

Barudan 3 

ZSK TC 4 

Melco 5 

Fortron 8 

SLC 9 

SHC 10 

NC 11 

ZSK ZEPL 12 
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B. Stitch Program Quick Reference 

Program ID Use Case 

Stitch Sequence 5 Control execution order 

ComfFill Block 6 Segmented block fill 

Comfort Line 7 Running/outline stitches 

Chaining 8 Connect repeating blocks 

Arrange 9 Circular/angular distribution 

ComfFill Plus 10 Complex area fill 

Cross Stitch 11 Counted cross-stitch 

Cross Boll 12 Raised decorative elements 

Comfort Fill 13 Standard area fill 

Curved Fill 14 Organic curved fill 

Monogram 16 Monogram generation 

Monogram GiS 17 GiS-based monogram 

Structured GiS Fill 18 Structured vector fill 

ComfFill GiS 19 GiS Comfort Fill 

Paillette Line 20 Sequin along line 

Paillette Area 21 Sequin area fill 

Area Program 22 General area program 
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C. Design Program Quick Reference 

Program Description 

Drill Screw (51) Layered drill-style column 

Pull Screw (52) Pulled-thread screw column 

Double Pull Screw (53) Parallel pull-screw columns 

Pull Hollow (54) Open-work pulled fill 

Fabric Hollow (55) Woven fabric texture fill 

Honeycomb Hollow (56) Hexagonal pattern fill 

Drill Hollow (57) Open-work with drill holes 

Brick Fill (58) Brick-wall pattern 

Grid Hollow (59) Lattice pattern fill 

TrueType Monogram (60) Font-based monogram 

Drill Hole (61) Round eyelet 

Border (62) Single decorative edge 

Double Border (63) Dual decorative edge 

Cross Boll (64) Raised cross boll 

Rapport (65) Pattern repeat 

Pear Hole (66) Teardrop opening 

Cut Hole (67) Slit opening 

Drill Rectangle (68) Rectangular opening 

Winding Line (69) Spiral wrap line 

Cut Hole 2 (70) Variant slit opening 

Drill Semicircle (71) Semicircular opening 

Flat Stitch (72) Satin/column stitch 

Step Stitch (73) Running stitch line 

Curved Brick (74) Curved brick fill 

Curved Fill (75) Organic curved fill 

Maze (76) Maze pattern fill 

Parallel Fill (77) Parallel line fill 

Spiral Fill (78) Spiral pattern fill 
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D. Special Stitch Functions Reference 

Code Function 

201 Needle Change 

202–204 Stitch Length Filters (1–3) 

205–206 Angle Filters 

207 Auto Rotation 

208 Rotation Angle 

210 Stop 

212 Drill 

213 Trim (Thread Cut) 

214 Kettle/Moss/Winding 

215 Cord 

216 Loop 

220–221 Sequin Right / Left 

222 Application (Appliqué) 

230–231 Jump to Start / Jump + Needle 

237 Marker 

240 Reserve 

241 Pattern End 

242–244 Sequence 1/2/3 

270–271 Bead Device Right / Left 
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E. Glossary 

Term Definition 

Punch / Digitize The process of defining embroidery data by placing 
reference points. 

Contour (Kontur) The outline that defines the boundary of a fill area or 
column. 

Comfort Fill EPCwin’s primary area fill algorithm using parallel rows of 
stitches. 

Flat Stitch (Plattstich) Satin/column stitch – stitches span the full width of a 
narrow shape. 

Comfort Line Running stitch path following a line. 

GiS Fill Advanced fill algorithm from the GiS vector engine. 

Paillette Sequin – a small decorative disc secured by stitches. 

Bore Effect A stitch pattern that creates a physical hole in the fabric. 

Pull Compensation Widening of a fill to counteract fabric shrinkage during 
stitching. 

Underlay A base layer of stitches placed before the main fill for 
stability. 

Density How closely packed the stitches are. Lower values = 
denser fill. 

RSL (Running Stitch Length) The length of each individual stitch in a running line or fill 
row. 

Jump Stitch A long connecting stitch between distant design 
elements. 

Trim A thread-cut command that cuts the thread cleanly. 

Rapport A repeating pattern element. 

Spline A smooth mathematical curve used to represent contours. 

Auto-Punch Automatic conversion of vector shapes into stitch data. 

MusterInfo Pattern information header containing design metadata. 

ProProtect EPCwin’s design protection/password system. 

W-Kopf / K-Kopf / F-Kopf Winding / Kettle / Frill machine head types. 
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